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Preface

The Xavier’s Resource Centre for the Visually Challenged (XRCVC) is happy to present this compilation of standards as culmination of its experience in the area of creating accessible reading material for blind and low vision persons. XRCVC has worked extensively over the years in creating accessible books through its robust volunteer system. We have endeavoured to create norms which are based on feedback from our diverse user base across age groups and content needs. 

What are presented here are standards for creating a Master which can be used to create EBooks, DAISY Books and Braille Ready Files. The rational guiding this work has been to develop a more efficient accessible book process where endless duplication is reduced to the minimum and diverse user needs in terms of format can be served through a single streamlined process.

This version 1.0 will be a continuously evolving work which will be regularly updated with new user experiences. We welcome feedback from you to help build this further.

It needs to be seen not as an end process but rather as the beginning of a journey which will evolve based on constant usage and feedback.

About XRCVC

The XRCVC is a state of the art support and advocacy centre for persons with blindness and low vision.
It is a department of the St. Xavier’s College, Mumbai, India, and works actively in the areas of providing Direct Support and Training Services to blind and low-vision persons, Awareness Generation and Advocacy Initiatives.

The XRCVC works actively towards creating an inclusive environment both at the micro and the macro levels. Some of the key areas of its advocacy initiatives lie in the field of Print Access, Financial Access, Education Access and Independent Living.
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SECTION 1 – HANDOUT ON ACCESSIBLE BOOK CREATION 
(MASTER COPY)

Types of Accessible Books for a Blind or Low Vision student:

Braille Book
E-Copy: Word file accessed with Screen Reader & Magnifier
E-Copy: DAISY file with Screen Reader / DAISY-specific software

Basic Information:

What is Braille?
Braille is not a language but a script used by the blind. It is written within a six-dot unit called a Braille Cell, as shown below.

Combinations of these dots make up the Braille alphabet. It also includes symbols to represent punctuation, mathematics and scientific characters, music, computer notation and foreign languages.

What is a Screen Reader?
A screen reader is a software that reads out screen content to allow those who are blind or low vision to use the computer / phone / tablet etc.

What is a Screen Magnifier?
A screen magnifier is a software that presents screen content in an enlarged manner. Such softwares also provide colour contrast options, mouse enhancements etc. to make the use of a computer / phone / tablet etc. easier for those with low vision.

What is OCR?
Unlike regular scanning procedures, Optical Character Recognition (OCR) technology allows the scanning of any printed text such that it becomes readable by synthetic speech. This helps to make hard copy materials accessible to persons who are blind or low vision, and who otherwise would rely on sighted assistance to read hard copy materials.

What is DAISY?
DAISY stands for Digital Accessible Information System. It enables the print-disabled population to access information almost as easily and efficiently just as a sighted person does while using a printed book. Other books are a single format but DAISY books are comprised of multiple file formats including text, audio etc. DAISY books may be accessed on computers, mobile phones or other special DAISY players.
DAISY features include several navigation options like go to page, go to heading, go to bookmark etc. When you return to reading after a break, your book opens to where you stopped reading. Various magnification and speech options are available.


Book Creation Process at the XRCVC:

I. Scanning

For Image scanning
Scan the book for any images that would need to be inserted into the Word file
Decorative borders, textboxes etc. are not to be considered for image scanning.
However, images of people, animals etc. even if not linked to the text, are to be scanned for insertion in the files.

For OCR scanning
Scan the complete book cover to cover so that all text matter is inserted into the Word file

	Image Scanning
	OCR Scanning

	All pages with images only
Front and Back Cover included
	Complete book – cover to cover




Steps to follow for scanning…

Image Scanning (Epson, HP)

For Image Scanning with EPSON Scanner –
Double click on the EPSON Scan icon on the Desktop.
Two windows open, one showing options and the other window showing a preview. The preview is from the previous scan.
Click on the folder icon on the EPSON Scan window.
Add a prefix (what the image should be named – ideally the page number).
Ensure that the Image Format is JPEG. You may select the Check Box to Open image folder after scanning.
Click on OK.
Change the Resolution by selecting the dpi value of 200. This avoids resizing of images later.
Place the book face-down in the scanner.
Ensure to keep it straight, aligning it with the borders on the scanner.
Click on the Preview button.
Right-click over the Preview window to have the selection border activated.
If the preview is satisfactory, click on the Scan button.
The folder opens automatically after a scan, if the corresponding option was selected earlier.

For Image Scanning with the HP Scanjet 200 –
Place the book face-down in the scanner.
Ensure to keep it straight, aligning it with the borders on the scanner.
Shut the panel.
Click the button on the scanner which has a scanner icon.
Here, it appears at the front facing side of the scanner.
A Scanning from… Scan button (Front Panel) dialog box appears on the screen.
Under Scan Shortcuts, select the Picture to JPG File option.
Click on the Scan button.
When the scanning is finished, adjust the selection, where required.
Click on the Finish button.
A Scan More Pictures dialog box appears on the screen, giving instructions to click on Scan, if you want to continue scanning OR click on Done if you have finished scanning.
When you finish scanning the required pages, click on Done.
The computer automatically opens the location of the image.

For Image Scanning with the HP Scanjet Pro 2500 f1 –
Place the book face-down in the scanner.
Ensure to keep it straight, aligning it with the borders on the scanner.
Shut the panel.
Double click on the HP ScanJet Pro 2500 f1 Scan icon on the desktop. A dialog box opens.
Ensure that the Save as JPEG option is selected and click on Scan.
When the Scanning is done, make sure the image is selected and Click on Save.
A dialog box opens, enabling you to select the folder where you want your file to be saved.
The default folder is Documents.
To continue scanning more pages, click on the  symbol, i.e. the Add more pages from the scanning device option.
Then make sure all of the pages that need to be saved are selected; (this can be done by Ctrl + A OR while keeping the Ctrl button pressed, click on each of the images) and click on Save.
The computer automatically opens the location of the image.

For Image Scanning with the HP Scanjet G3110 – 
Place the book face-down in the scanner. 
Ensure to keep it straight, using the rulers given on the scanner. 
Shut the panel. 
Click the button on the scanner with a scanner icon.
Here, it appears as the biggest button on the scanner’s panel.
A Scanning from… Scan button (Front Panel) dialog box opens. 
Choose the Picture to File option. 
Click on the Scan button. 
Provide a name for the file and browse the location where you want it to be saved. 
Click on the OK button, when done. 
When the scanning is finished, adjust the selection, where required. 
Click on the Finish button.

The computer automatically opens the location of the image.

Ensure that all the required images are saved in a folder named IMAGES.
Hence, each book will have one IMAGES folder within its main book folder.

OCR Scanning
(With Kurzweil 1000)

Place the book face-down in the scanner, within the rulers.
Double click on the Kurzweil 1000 icon on the Desktop.
It voices out instructions.
Ensure that the focus is on Kurzweil 1000 window and your Num Lock is off.
Press the + key on the Num Pad to start scanning. Repeat this step to add consequent pages in the same file. Press Page Down to check the next page and Ctrl + End to go to the end of the document.
Once the required pages have been scanned, click on File Menu.
Click on the Save As.
Edit the File Name, as required – ideally the name of the book.
Change the File Type to .docx (by changing ‘KES’ to ‘MS Word 2007’).
Click on OK.
The default location where OCR files are saved is: 
Documents / My Documents > Kurzweil Education Systems > General

Using the auto feeder for both Image Scanning and OCR.

How to use the HP ScanJet Pro 2500 f1 (auto feeder option) to convert files into a softcopy with OCR (Kurzweil) –
i.	Separating the pages.
For a book: Tear apart each page in a book, ensuring smooth edges, you may use scissors to cut the side of the pages that were attached to the book.
This requirement is met, so that the pages don’t jam the auto-feeder and disrupt the process.
For Notes/xeroxed pages: Take the staples off and ensure smooth edges, as mentioned above.
ii.	Place the pages on the Document Feeder, (the correct side facing you/ so the top of the page goes in first) and adjusting the width, accordingly.
(Note: The OCR file will recognise text that is oriented in any direction.)
iii. 	Select the pdf option on the scanner. Use the  button on the scanner to move through the options. You know it is selected, when the white light under the option lights up, as so:

iv. 	Click on the  button to start scanning.
v.	When done, the Documents folder opens automatically, with the pdf file selected.
vi.	This pdf can now be recognised by OCR. (Right click on the pdf file in the folder. Choose the Open with option and select Kurzweil 1000)
vii.	Refer to OCR Scanning below to save and name the file, once the recognition is done.
This is now, to be saved in the corresponding folder of the book.

II. Saving, Keeping & Naming Files and Folders

Create a folder and give it an appropriate name as follows. Give the single Master Copy file the appropriate name as well.

Author Surname, Author Name, Book Name, Edition Number, Year of the Edition
Example:
Ganjee, Nazirah & Chowdhury, Baruna Ray, NEW LANDSCAPES PRIMARY GEOGRAPHY 1, 2nd Edition, 2015
Ganjee, Nazirah & Chowdhury, Baruna Ray, NEW LANDSCAPES PRIMARY GEOGRAPHY 1, 2015
Murphy, Raymond, Essential English Grammar, 2nd Edition, 1998, 69th Reprint, 2012

The single OCR Word file will have the same name as the folder.
The name of the book will be decided as per the name that appears on the first page inside.

If the edition number is not present, mention the year of the edition without fail.

Ensure that all the required images are saved in a folder named IMAGES.
Hence, each book will have one IMAGES folder within its main book folder.


III. Editing / Proofreading / Formatting Stages:

After the scanning, the file that you work on will be used to make the Final Accessible Word File, the DAISY book and a Braille hard copy book, so that the same book will be ready to share with different people depending on their needs and preferences.

For ease of process, we have classified these as three types of Word files that will need to be created, as follows:

Master Copy Word File:
This file will involve almost all the editing, proofreading and formatting; and is the base which will be used to create the below three files.

Braille Ready Word File:
This file will involve editing as required for Braille printouts; and will be used for translation into Literary Braille (text content) or Nemeth Braille (Maths content) with the help of a Braille translation software.

Final Accessible Word file:
This file too will involve minimal editing and can be read directly by the student.

D.    Digital Accessible Information System (DAISY)
This file will be created with the help of a DAISY conversion software.


A. Master Copy Word File

1. Copy-Paste – Unformat

Why?

The OCR scanning throws up errors due to different fonts, formatting, images etc. in the hard copy that is scanned. The first step is to clear this text and directly remove all formatting fluctuations by saving all text in unformatted style. Such unformatting is necessary for a well-made accessible book.

How to?

In the file that you are working, follow this process:
Press Ctrl+A (to select all).
Press Ctrl+X (to cut what is selected).
Press Ctrl+V (to paste what is cut).
Immediately after pasting, at the bottom right side of the last line of what is pasted, click on the  symbol next to (Ctrl).
Click on the option A i.e. the Keep Text Only.


Ensure that the Font is standard Calibri, 11 and that everything is left aligned.

Press Ctrl+A.
Select Font Calibri, Font Size 11.
Click on the  symbol i.e. the Align Text Left button.
Picture: This is the ‘Align Text Left’ button in the Paragraph group.


2. Cleaning up extra Spaces, Tabs, Enters etc.

Why?
 
Unformatting of text by following the process above is only the first step of the clean-up. Next, you have to pay closer attention to look into details.
There may be multiple Spaces where only one is required; some Tabs may appear as Spaces. The OCR process may recognise the Spaces between lines as Enters etc. All this should be cleaned up as explained below.

How to?

To begin the editing of the unformatted text, you first have to remove unwanted Spaces as follows:
Press Ctrl+Home (to go to the beginning of the file).
Press Ctrl+H (to open the Find and Replace dialog box).
In the Find what: field, type two Spaces (because you have to get rid of double spacing).
In the Replace with: field, type a single space (so that a single Space is used instead of a two Spaces).
Click the Replace All button (to make the required changes in the entire file at once)
Note:
In case, there are three Spaces at any position in the document, logically, they will be reduced to 2. So you would need to remove that one extra space using the same steps again. Hence, it is advised to click the Replace All button multiple times, till it informs you that it made 0 replacements.

Similarly, to remove unwanted Tabs, you will follow similar steps:
Press Ctrl+Home (to go to the beginning of the file).
Press Ctrl+H (to open the Find and Replace dialog box).
In the Find what: field, type ^t (^t is the code to find a Tab).
In the Replace with: field, type a single Space (so that a single Space is used instead of a Tab).
Click the Replace All button (to make the required changes in the entire file at once)

Most of the errors mentioned above may be difficult to spot since they all appear blank.
Therefore, you should switch on the option for other hidden formatting symbols:
In the Ribbon / Menu, go to the Home tab.
Under the Paragraph submenu, click on the  symbol i.e. the Show/Hide option.
When this is switched on, the symbols are shown as follows…
Spaces are represented by 
Tabs are represented by 
Enters are represented by 

When you notice  at the end of a line even if it is not the end of a paragraph, make sure to replace the incorrectly recognised character (Enter) by the correct one (Space).
To do this, you may either:
Position your cursor at the end of the line where  appears.
Press the Delete button.
Now, press the Spacebar.
OR
Position your cursor at the beginning of the line below the  symbol.
Press the Backspace button.
Now, press the Spacebar.

Another way to spot this inaccuracy is by looking out for the errors recognised by MS Word itself.
Whenever you notice a green or red wavy underline…
Position the cursor in the middle of the relevant word / phrase.
Right-click to look for correct options.
OR
In the Ribbon / Menu, go to the Review tab.
Under the Proofing submenu, click on the Spelling & Grammar option.

The example below shows errors like an incorrectly recognised Enter and Tab within a raw OCR’d file, which need to be changed.









Below is the corrected version of the above example.


Extra Blank Lines (Enter) to be used only as follows.
- Before and After the Chapter name line
- Before and After the Page Number line
- Before and After a Picture
- Before and After a Table
- Before beginning a Text box and After ending a Text box
- Only Before Section Headings and Subheadings (NOT AFTER)
- In case of an overlap on space, always leave a single line. Never leave double lines

3. Inserting Copyright Notice & Cover Page Info

Insert Copyright Notice from the separate file as the first page of the book.

All the text content relevant to the particular book is to begin on a New Page.
Use Ctrl+Enter to insert a page break before the main text.
Do not press Enter multiple times to go to a new page.
Therefore,
Page 1 = Copyright Notice
Page 2 onwards = Textbook Content beginning with the Front Cover

On a new page, after the Copyright Notice, the whole scan of the front cover will be inserted as an image with appropriate Image Description (Alt Text) for the same. Ensure that the Alt Text explains the placement of different aspects on the page.
E.g. Top-centre: Global IT Challenge; Centre: image of three computers; Bottom-right: SAGE Publications; Bottom-centre: Government of India logo


4. Inserting Page Numbers

Why?

Most often, teachers in schools ask students to "Open to page __." When a blind or low vision student studies in an inclusive school, these numbers will not match the Braille pages or the Accessible E-Copy file pages. Hence, you need to insert page numbers as per the sighted print textbook so that the visually impaired student can literally, 'be on the same page' as the rest of the class.

How to?

Use 20 hyphens (--------------------), followed by the word Page and then the number.
Note:
Be careful not to add a space between the hyphens and the word Page.
Example:
--------------------Page 65

In Hindi/Marathi, follow this:
--------------------पृष्ठ ६५

Note:
In some print books, the page numbers may appear at the bottom of the page, and in some at the top of the page. Always enter the page number at the start of the page in the Word file i.e. before the relevant content.

For initial and final content present on pages that are not part of chapters, we use these words appropriately.
Example:

--------------------Front Cover

In Hindi, follow this: 
--------------------सामने का कवर

In Marathi, follow this: 
--------------------मुखपृष्ठ


--------------------Inner Front Cover

In Hindi, follow this: 
--------------------भीतर का सामने कवर

In Marathi, follow this: 
--------------------आत मुखपृष्ठ


--------------------Inner Back Cover

In Hindi, follow this: 
--------------------भीतर का पीछे कवर

In Marathi, follow this: 
--------------------आत मलपृष्ठ


--------------------Back Cover

In Hindi, follow this: 
--------------------पीछे का कवर

In Marathi, follow this: 
--------------------मलपृष्ठ

For pages (apart from the above four pages) that don't have a page number, follow the 20 hyphen rule and insert the words “New Page”.
Example:
--------------------New Page

In Hindi, follow this: 
--------------------नया पृष्ठ

In Marathi, follow this: 
--------------------नवीन पृष्ठ

In case you come across a new page which is blank (no text or images), you need to insert the following statement in brackets.

For books in English:
(This is a blank page.)

For books in Hindi:
(यह खाली पृष्ठ है।)

For books in Marathi:
(हे रिकामी पान आहे.)


5. Handling Images

Why?

All books are made considering that either a blind or a low vision student might use it. Hence, all images from the textbook will be scanned, cropped, and added to the Master Copy file.
Decorative borders, textboxes etc. are not to be considered for image scanning.
However, images of people, animals etc. even if not linked to the text, are to be scanned for insertion in the Master Copy. All Crosswords, Word Puzzles, Mazes etc. will be treated as images.
Image Description (Alt Text) needs to be added for every image inserted, as far as possible.
However, tactile diagrams are to be created only for relevant diagrams, as decided by the staff in charge.


How to?

Paste the image in the Word file.
Position the image either before or after the relevant text content that is connected to the picture, but never in the middle of a paragraph.
Double-click on the image. (This opens the Format tab in the Menu bar.)
Click on the  symbol i.e. the Crop option.
Always crop the image only from the 4 corners - i.e. bottom-right, bottom-left, top-right or top-left.
This is done so that the proportion of the image is maintained.
Crop the image as close to the required portion as possible, without cutting off any relevant lines.
Sometimes, captions appear below / above images. Make sure to include the captions of all images as part of the picture to be pasted. Hence, the caption will also be part of the Alt Text, as explained later.
Paste the image in the document with a blank line before and after it.
When separate images are found next to each other, place them one below the other in the Master Copy file.
Do not add additional numbering to pictures within the description. When there are multiple images, and they get placed one below the other, follow the correct example below.
The example below is correct.
1. Picture:
2. Picture:
The example below is wrong.
Picture 1:
Picture 2:
When there are images in Match the Column questions, use the same format of placing images one below the other. Use additional numbering, as required.
When flowcharts with images are present, crop the whole flowchart as a single image, and do as explained above.
When there is a tactile diagram / real object / activity for an image, add this note below the inserted image. (This will be marked on the hard copy given to you. If not, check with relevant staff as and when you come across an image.)
(Refer to tactile diagram.) 

In Hindi, follow this: 
(स्पर्शनीय आरेख को देखें।)
In Marathi, follow this: 
(स्पर्शाने जाणलेला आकृती पहा.)

(Refer to objects.) 

In Hindi, follow this: 
(वस्तु को देखें।)
In Marathi, follow this: 
(वस्तु पहा.)

(Do this as an activity.)

In Hindi, follow this: 
(इसे एक गतिविधि के रूप में करें।)
In Marathi, follow this: 
(एक क्रियाकलाप हे असे करा.)

When the users reach that part of the text, these notes inserted below the image inform them about attachments, or activities to be conducted.

Inserting Alt Text after pasting the image…

Select the image and right-click to select Format Picture as shown below.
In the Format Picture dialog box, choose Alt Text.
Add the image description in the Description box.
Begin all image descriptions with “Picture: ” 	In Hindi/Marathi, follow this: चित्र:
For images which already have a caption, the caption forms part of the Alt Text with a space, hyphen, space ( - ) separating the caption and the description.
Close the dialog box.
	

Keep in mind the following points when writing the Alt Text (description of an image).
Give detailed explanation which would aid the lesson.
Read the text around the images to make sure you are using the same terms as the text.
If the image description is going to be word to word (or only slightly different from the caption already given, there is no need of the description to follow the caption.
Wrong Example,
Picture: Fig. 9.3 Main screen of Tux Paint - main screen of Tux Paint
Read and understand the context of the image. As far as possible, the description of the image should not readily give the child the answer which he/she is expected to find out. In such cases, consider tactile diagrams.
Example, if in the textbook the student is required to identify a shape; the image description should be:
Picture: A shape
(Refer to tactile diagram.)
and not ‘Picture: a square’.
Sometimes, captions appear below / above images. Insert the caption as part of the Alt Text, as mentioned under iii.

Here is an example of an image in the Computer textbook.

When describing this image, use the words tab, group etc. as used in the text.



Examples of Image Description-



Alt Text for the above image:
Picture: A boy speaking to his computer…
BOY: Hi Toggle, can you teach me a little about computers?
COMPUTER: Oh sure, Goggle! Come I’ll introduce you to the parts of a computer and to the start and shut down procedures.



Alt Text for the above image:
Picture: Coins and paper notes make up the Indian currency. - Indian currency including coins of Rs.10, Rs.5, Rs.2, Re. 1 and 50 paise, beside notes of Rs. 500, Rs. 100, Rs. 50, Rs. 20, Rs. 10 and Rs. 5


Also check for Style Guides at https://diagram.herokuapp.com/training/how_to_describe
While you can use your judgement to create Alternative Text / Image Description, do run your ideas by the XRCVC staff who has assigned the work to you. As the nature of description is very contextual and may be different in different situations, highlight in yellow all the changes you have made in the file for easy future reference. Check with the relevant staff whether description is required in detail, or tactile diagram is to be created.

Note:
The Alt Text will be written in the relevant language – Hindi Alt Text for Hindi books, Marathi Alt Text for Marathi books.


NOTE FOR POINTS 6 to 17
Many a time, reference text, exercises & activities in the sighted print book may not be accessible if left as they are in the Master Copy book used by the blind or low vision student. Hence, one needs to use their discernment and edits should be made accordingly.
Especially because textbooks are typically very visual and pictorial along with providing Image Descriptions as well Tactile Diagram Supplements with the accessible content, certain modifications to the text may also be required.  These adaptations need to be considered and will differ each time in each context. Always check all changes.

Here are a few examples of adaptations typically made to textbook materials when converting them to accessible books.



6. Replacing Visual Words
(NOT APPLICABLE to books from Class 11 onwards)

Questions such as ‘Tick the, Colour the, Circle the, Underline the, Cross out the…’ etc.  are to be modified to either of these options:
Write the…,  Pick the…, Choose the …, Mention the …, or State the ….

Change ‘Fill in the boxes / grid etc…’ to Fill in the blanks.

Questions like ‘Fill in the blanks with the words given in the box / cloud / tree’ etc. should be changed to Fill in the blanks with the words given in brackets.
Note:
Here we use round brackets / parentheses.

For Match the Columns, instead of ‘Draw lines to match’, change the text to Mention the correct option number. or simply Match the columns.

In Handwriting books, change ‘Trace and write the following sentences.’ to Write the following sentences.

Since we will be using bold instead of colour, in cases where the text says, ‘Refer to the words in colour.’, we put each relevant word / phrase in Bold. The text will have to be edited accordingly as Look at the words in bold.
	In Hindi text, make the change using the words below:
Example: रंगीन छपे शब्दों से सर्वनाम चुनो|
Master Copy: मोठे छपे शब्दों से सर्वनाम चुनो|





7. Handling Visual Marks
(NOT APPLICABLE to books from Class 11 onwards)

Also, where answers have been Circled / Crossed / Boxed / Struck through or for visual lines showing answers of Match the Columns, in order for the sighted student to know; this may be represented in simple text as shown below.

Example 1:false

a. true – beautiful	bad      			same

Master Copy:
Ans. true - false


Example 2:



	Common Nouns
	Proper Nouns

	1. country
	a. Gateway of India

	2. city
	b. Shikhar Dhawan

	3. building
	c. Ramayana

	4. cricketer
	d. Japan

	5. car
	e. Tokyo

	6. river
	f. Nanda Devi

	7. book
	g. Chevrolet

	8. mountain peak
	h. Godavari



Ans.: 1. - d


Example 3:


उत्तर: लालची



8. Retaining Visual Instructions

When questions mention to draw, do not change the question, since the visually impaired child should have practice in drawing as well.
You do not need to alter statements like, ‘Look at the words below.’ The child will be looking and reading with their fingers and/or ears.
Activities involving colouring need not always be substituted or removed.
A blind child can be expected to colour within tangible boundaries on tactile diagrams provided. If the activity / exercise can be made more interesting / appealing to the child by colouring, the question should be kept as it is and an appropriately created tactile diagram should be provided for the same, with the note (Refer to tactile diagram.)
Even within e-copies, shading, highlighting or a font colour change may be applied to the required text once selected.



9. Additional Numbering

Some books may not include question numbers as the sighted students are expected to fill in their answers in the textbook / workbook / worksheet itself. Questions of this kind would need to be numbered since the student using the Braille book would be answering these questions on a separate sheet and inserting question numbers will help the student link them to the original questions.




Note:
If question numbers are already mentioned, do not change them.

In exercises, when a student may be required to pick out answers from a list, change all symbolic bullets to numbers instead.

Example:



Master Copy:
While speaking, we often make some very common mistakes. In each pair, one sentence is incorrect.
Do you know which one?
1. a Today morning I got up at 6 o'clock.
1. b This morning I got up at 6 o'clock.



For Match the Columns:
In case of information in columns without headings, give names Column A and Column B.
All items in all columns should be numbered so that the user does not have to write the entire word / phrase / sentence in the answer sheet.
Depending on the original text in the sighted print, if one of these sequences is already used in one column, choose from another series for the remaining columns.
1. 2. 3. …, a. b. c. …, i. ii. iii. …, A. B. C. … etc.

For questions without answer options i.e. not MCQs
First level – A. B. C. or I. II. III.  (Based on previous book numbering)
Second level – 1. 2. 3.
Third Level – a. b. c.
Fourth Level- i,ii,iii

For questions with answer options i.e. MCQs
First level – 1. 2. 3.
Second level (options)– a. , b., c.

For Tree Diagrams
Breakdown Tree Diagrams such that the meaning may be understood by numbers.
First level = 1
Second level = 1.1, 1.2, 1.3…
Third level = 1.1.1, 1.1.2, 1.1.3… & 1.2.1, 1.2.2, 1.2.3… & 1.3.1, 1.3.2, 1.3.3…
and so on.

In case of only one layer / level… they will be treated as bullets & two hyphens (--) will be used, as mentioned in Point 11 below.

All numbers are followed by a full-stop, and a space.


10. Handling Lists

Why & How?

Lists of words & phrases are shown in different ways at different times in sighted print textbooks. However, to maintain as much uniformity as possible, and so that the visually impaired child does not get confused, you will do the following:

Multiple Choice Questions (MCQs): Applies to options given for each question

Numbered Lists
They are to be arranged one below the other.

Example 1:


Master Copy:
C. Speak out the degrees of comparison of these words: (for oral practice)
1. wide
2. soft
3. lazy
4. sweet
5. cheerful

Bulleted Lists 
(FOR BULLETED LISTS, follow rules as per those given in point 11 below.)

Example 2:


Master Copy:
2. before the names of things that are only one of their kind:
--the sky
--the earth
--the moon
MCQ Bulleted Lists
In exercises, when a student may be required to pick out answers from a list, change all symbolic bullets to numbers instead. (Follow the numbering rules as per Point 9 MCQ section)

Example:



Master Copy:
While speaking, we often make some very common mistakes. In each pair, one sentence is incorrect.
Do you know which one?
1. a Today morning I got up at 6 o'clock.
1. b This morning I got up at 6 o'clock.

MCQ Non Bulleted Lists
When non-bulleted or non-numbered options are presented without brackets and commas, place them horizontally in a line in round brackets, separated by a comma, and a space.

Example 1:


Master Copy:
K. See the pattern and then fill in the blanks with the following words:
(mine, ours, yours, his, hers, theirs)


Example 2:


Master Copy:
सकर्मक व अकर्मक क्रियाओं को छाँटकर अलग-अलग लिखिए।
(डरना, हँसना, खाना, सुनाना, तोड़ना, जागना, रोना, सींचना, बुलाना, चमकना)
If non-numbered options are given in brackets, next to each other, with commas or slashes keep as is.





In case options are separated by commas or slashes, but not put within brackets, then add round brackets around the relevant words or phrases.

Example:


Master Copy:
1. January is the (colder/coldest) month of the year.
2. Mumbai is (big/bigger) than Delhi.
11. Handling Bullets and Sub-bullets

Why & How?

The various visual bullets typically inserted in Word may not always be read out by screen readers. Further these do not get transliterated correctly in Braille.
In Braille, the convention is to use dots 2, 5 twice i.e. two hyphens (--) before a bulleted point, with no space before and after.

Example:
apple
mango

Master Copy:
--apple
--mango

In the case of sub-bullets, we begin numbering. Therefore…
Bullets: --
Sub bullets:
1.
2.
3.

Hence, Bullets with sub-bullets are treated similar to Tree Diagrams numbering listed in point 9., except for the first level, which will be two hyphens followed by no space.

Note:
It is important that you insert these bullets manually and not use the automated bullets feature in Word. Use of the automated bullets disrupts the alignment of text in the file.
A student using the accessible E-Book may need to add his answers in the same Word file and may need to press Enter to write his answer below. Pressing Enter after automated bullets in a Word file causes additional automated bullets which may lead to confusion.

All numbers are followed by a full-stop, and a space.



12. Handling Tables

Why?

One can easily navigate through tabular information in an E-Copy book using a Screen Reader which announces the Column number & Row number & the relevant information. On entering a table, the software gives an overview of the total number of columns & rows.


How to?

To insert information in tables:
In the Ribbon / Menu, go to the Insert tab.
Click on the Table dropdown & select the number of rows and columns from the grid, as required.
Click on the last needed cell at the bottom-right.
Click on the OK button.
OR… replace steps ii & iii with the following.
Click on the Table dropdown.
Click on the Insert Table option which will open a dialog box where you enter the Number of Columns & Number of Rows required.

Use tables for all topics where one needs to read the columnar information line wise.

Here are some examples of where tables are to be inserted:

Subject & Predicate
Example:


Master Copy:

	
	Subject
	Predicate

	1.
	Birds
	fly

	2.
	The sun
	rises

	3.
	The moon
	shines at night



Correct & Incorrect statements
Example:


Master Copy:
Use the words tell, told, say and said correctly:

	What we should not say
	What we should say

	I will ‘tell to’ the teacher that I cannot do this sum.
	I will ‘tell’ the teacher that I cannot do this sum.

	My mother ‘told to’ me to finish my homework.
	My mother ‘told’ me to finish my homework.



The Table of Contents is always presented as a table.

Bullets & sub-bullets will be in the same cell.

Example:


Master Copy:
	Unit
	Comprehension
	Working with Words
	Learning about Language
	Listening & Speaking
	Composition / Activity

	1. Message in a Bottle
	A short tale with plenty of conversation
--Questions
--Recall: true or false
--Reference to context
	--Anagrams
--Spelling
--Sentence completion
	--Nouns
--Sequencing
	--Question tags
	--Composing a paragraph using the words given




13. Handling Fill in the Blanks

Why & How?

For creation of Braille books, a blank (that needs to be filled) is conventionally represented by dots 3,6 thrice. The sighted print hyphen (-) translates to the required dots.

Fill in the blanks within sentences.
Hence, all blanks, blank boxes, dotted blank lines, dashes, underlines…etc. will be replaced by 3 hyphens with a space before and after them ( --- ).

Example:

Master Copy:
B. Fill in the blanks using the words given below.
(caterpillar, embryo, chick, lifespan, spawns)
1. When a baby bird comes out of an egg, it is called a ---.
2. --- are the egg clusters laid by female frogs.

Within a table…
Blank cells of a table will be retained as blank cells. Hence, there is no need of entering 3 hyphens to represent a blank within a cell.
In case the sighted book shows a few dots or a question mark, only then will we keep as is in the sighted book.

Single letter blanks as part of work puzzles and pyramids
When asked to fill in single letters or numbers as part of word puzzles or word pyramids etc. Use only a single hyphen for each character (either letter or number), with no space before or after.

Example 1:


Master Copy:
Fill in the vowels in the following verbs.
1. D-NC-
2. --T


Example 2:


Master Copy:
G-
G--
G---
G----
G-----
G------
G-------
G--------
G---------

Fill in the blank for entire lines
In Handwriting books / Worksheets etc., in case of an entire line of dots, or dashes, or a number of blank lines, we ignore the blank lines; and only put down the questions / statements one below the other. Hence, there will be no representation of blank lines.

14. Handling Text in Boxes

Why?

At times, information is presented in boxes only for visual effect. For example, at the beginning of a lesson etc. Such content can be typed in the E-Book with just the heading / subheading (and no representation of a box).
However, there may be some facts, or Quick Tips, or Did You Know? kind of information that may appear at different places in the middle of the main text content with or without consistency.

How to?

In order to distinguish the text within and outside the boxes, do the following.
To insert information in a box:
Add 5 hyphens (-----).
On the next line, type Text Box begin.
Insert all text that has to go within the box, as required.
On the next line, type Text Box end.
End with 5 hyphens (-----) again on the next line.


Example:


Master Copy:
-----
Text Box begin
In this Chapter
--What is a Computer?
--What is a Computer made of?
Text Box end
-----

For Hindi, follow this:
-----
पाठ बॉक्स शुरू
…
पाठ बॉक्स अंत
-----

For Marathi, follow this:
-----
मजकूर बॉक्स सुरू
…
मजकूर बॉक्स शेवट
-----

15. Handling Bold, Italics, Underline

Why?

To allow the low vision students to have an almost duplicate copy of the sighted print, you would need to apply Bold, Italics, Underline as per the sighted print book.
Font Colours, however, will not be replicated. All the text matter will be Black (except the Heading Levels where you will maintain the colour).
To draw attention to words that are represented by colour, make the relevant text Bold instead.

How to?

When you unformat the entire OCR scanned file all Bold, Italics, and Underline get undone automatically. Wherever required, apply Bold, Italics, and Underline to words / phrases / paragraphs etc. as follows:
Select the relevant words / phrases / paragraphs.
Press Ctrl+B (for Bold) and/or Ctrl+I (for Italics) and/or Ctrl+U (for Underline).



16. Footnotes

Insert all footnotes in the text as footnotes in the Word file.

To insert footnotes:
In the Ribbon / Menu, go to the References tab.
Click on the Insert Footnote button.
The focus / cursor automatically jumps to the bottom of the page, where you can type out the footnote as seen in the sighted print text.


17. Handling Headings & Subheadings

Why?

This is done so that the student reading the E-Book can navigate through the Word file by jumping headings, sub headings and page numbers just like one would when reading a hardcopy print book.


How to?
This can be done by selecting the Heading Levels in the Menu ribbon in Word as shown here –



If the book is divided into Parts / Units…
Title of the Book: Heading 1
Parts / Units /Section/Modules/ Copyright / Preface / Foreword / Acknowledgements / Messages by Editor / About the Author / Contents/Index of words/Glossary: Heading 2
Chapter Number & Name/Worksheets/Revision/Review/Answers/Solutions: Heading 3
Subsections: Heading 4
Page Numbers (always the last heading level): Heading 5

If the book is not divided into Parts / Units…
Title of the Book: Heading 1
Copyright / Preface / Foreword / Acknowledgements / Messages by Editor / About the Author / Contents / Index of words/Glossary/ Chapter Number & Name/ Worksheets/Revision/Review/Answers/Solutions: Heading 2
Subsections: Heading 3
Page Numbers (always the last heading level): Heading 4

Note:
It is important that whatever system of level hierarchy is being followed should be followed for all volumes of a particular book.

18. Ending Your Scanning & Editing Work

When you finish your work for the session, at the end of the scanned or edited portion, mention that the document has been scanned / edited by you, and put down the page numbers that you scanned / edited during that particular session (based on the sighted print hard copy textbook, not the page number in the Word file).
Example:
Scanned by ABC XYZ Pages 1-20
Edited by ABC XYZ Pages 1 - 20

Highlight this line in yellow so that it becomes easy to spot by the next volunteer who will continue where you stopped.

Note:
Even if you are the only one working on a particular book, following this process will help you locate where you had left off.

How to adjust Line Spacing?
In the Ribbon / Menu, go to the Home tab. 
Under the Paragraph submenu, click on the  symbol i.e. the Paragraph dialog box option.
In the Spacing section, ensure that the Before and After values are 0; and the Line Spacing is Single.
Click on the OK button.

19. Proofreading

Why & How?

When you are proofreading the OCR scanned files it is important that you read the text like you would read a story book. EVERY WORD, EVERY LINE.
Skim reading through the file for proofreading does not work for an OCR scanned file. As typical OCR scanning errors are sometimes as small as the scanner displaying 1 (one) instead of I (capital i).

Also, as mentioned earlier, to spot this inaccuracy is by looking out for the errors recognised by MS Word itself.
Whenever you notice a green or red wavy underline…
Position the cursor in the middle of the relevant word / phrase.
Right-click to look for correct options.
OR
In the Ribbon / Menu, go to the Review tab.
Under the Proofing submenu, click on the Spelling & Grammar option.


Once the entire document has been edited as required, ensure that you remove all extra text that is mentioned for reference.
Since statements like “Scanned by ABC XYZ Pages 1-20” and “Edited by ABC XYZ Pages 1 - 20” are no longer necessary, they must be removed before you can claim that the document is ready to be used as the Master Copy.




Conversion to the Braille Ready Word File and the Final Accessible Word File
After working on the Master Copy Word File, only a few changes would be needed to prepare the following:
Braille Ready Word File which can be used to create Braille books
and
Final Accessible Word File which will be used with accessible screen reading software.

***


XRCVC's Accessible Book Production Standards 1.0


SECTION 2 – HANDOUT ON MATH CONTENT CREATION

Handling Math Expressions & Symbols – in the Master Copy

I. Scan Math Hardcopy Book

Additional Software Requirement for Scanning Math:
- Scanner Software (Based on the scanner you are scanning from)
- Infty Reader
- MathType by Design Science

Steps:
Step 1. Image Scanning:
Image Scan each page of the hardcopy textbook by selecting the following settings as shown in the images below;
[bookmark: _GoBack]- Under “Everyday Scan” ensure that the following options are selected and then click on “More”
Image Color Mode: Black/White
File Type: BMP

See image below.


Under “Images” section select “Resolution (ppi): 600 dpi”
See image below.


Step 2. Naming the Image files:
Ensure that each image file is named ONLY as shown below in the correct sequence.



Note: These numbers in the file name may not correspond to the page numbers that appear in the hard copy book because each hardcopy page (cover page, contents, preface, publisher details, etc.) numbered or non-numbered will be scanned.


Step 3. OCR scanning with Infty Reader:
Optical Character Recognition, or OCR, is a technology that enables you to convert different types of documents, such as scanned paper documents, PDF files or images into editable and searchable data.

Open all the scanned image files in InftyReader and choose the options as shown in the image below




Choose the options as shown in the image below and select “Start OCR”




Step 4. Converting the Equations to MathType equations:
Open the .xml file with MS Word and choose the option shown in the image below to convert the equations to MathType equations and wait. Ensure that the “Convert Equations” dialogue box shows the number of equations converted at the end.
Avoid doing any other activity on the PC while the equations are being converted as the file tends to hang on doing so.





Step 5. Save as a .docx file:
File > Save As > Save as Type: “Word Document (.docx)”



II. Inserting, Editing and Proofreading of Math Expressions & Symbols

All the sections for creating the Master copy file for literary books need to be followed for Math books as well, along with the additional points mentioned in this file. The exceptions to this are the following;
Section I Point 1. Image scan.
Section I Point 2. OCR scanning with Kurzweil
Section II Point 4. Naming and Saving of Image Folder
Section III Point 1. Copy Paste Unformat
Section III Point 13. Handling Fill in the Blanks

Caution:
For any new kind of symbol you are typing or unsure of, please highlight that symbol yellow and check with the relevant staff or someone with a Mathematics background. A wrong symbol will give errors when transliterated to Braille that may get missed out when proofreading the Braille file & will be read out incorrectly by the screenreader.

Software Requirement for Math Typing:
- MathType 6.9 by Design Science (dessci.com)
(Licensed version or the Free Lite version)
		
Software Requirement for Reading Math Expression with Screen Readers:
- MathType 6.9 by Design Science (dessci.com)
(Licensed version or the Free Lite version)
- MathPlayer by Design Science (dessci.com)
This is a free software that runs in the background and enables NVDA to recognise the Math equations.
- NVDA 2015.2 onwards (Non Visual Desktop Access) (nvaccess.org)
This is a free open source software.

The following are the steps to insert or edit Math Equations in the Word file:

Method 1:
- Go to the Start Menu and open “MathType”
A MathType Equation Editor Window as shown below opens on your screen. 
- Type out the equation using the appropriate symbols, etc., from the MathType Equation Editor.
- Copy-Paste these symbols to the Word file.
Or
Method 2:
While keeping the cursor in the position where you want the Math equation or symbol, press ‘Ctrl + Alt + Q’ or select ‘Inline’ from the ‘Insert Equation’ section in the MathType menu ribbon in the Word file.
A MathType Equation Editor dialog box opens on your screen.
Type out the equation using the appropriate symbols etc. from the MathType Equation Editor
Close and Save.







Refer to the links to the following in ‘Additional Information’ for more information on working with MathType:
https://www.dessci.com/en/company/training/misc/tipstricks-full.pdf
https://www.dessci.com/en/dl/MathType5WinManual.pdf
Or
Method 3:
- Double click on the MathType equation in the Word file
- The MathType dialogue box containing the equation opens up
- Edit the equation
- Close and Save the dialogue box



IMPORTANT NOTE:
Do not use the methods shown below – or any other methods – to insert Math expressions and symbols in the Word file.

- Do not Insert Math Symbols or Expressions directly from Word’s Insert Equation and Symbols feature shown below.

 

- Do not Insert Math Symbols or Expressions directly from the “Symbols” section on the MathType ribbon shown below.



Rules for Typing & Editing Math Equations

The list appended below is important to follow because not following this process causes errors in the Braille file that are harder to spot and could also cause the equation to be read out or transliterated to Nemeth Braille wrongly.

	
Rule #1. All Mathematical Expressions (i.e. not including plain numbers that are not a part of Math expressions) should be inserted with MathType.

Here are some instances;
Example 1: +
Plain numbers appearing throughout a book independently will not be Typed in MathType.
Example: Ram bought 50 pencils.
Here 50 is not typed in MathType.

Example 2:
Mathematical expressions in which all the symbols are available on the keyboard will also be typed in the MathType box.


Example 3:


Note: In the above equations the words “ones” and “tens” will be written in style: Text and with a space before and after it. This is discussed in later point.

Example 4:



Example 5:



Example 6:


Example 7:


Example 8:

3x =  is incorrect cause 3x is not typed in MathType

 is correct, where the entire expression is typed in MathType

Note: In the above equations the colon/ratio sign, the greater-than sign, the plus sign etc,. are typed from the keyboard but in the MathType window. There is no special symbol for some symbols like ratio sign, plus, minus, greater-than, less-than etc. in the MathType window. These are typed directly from the keyboard.
Signs of grouping (brackets) can be typed directly from the keyboard or can be selected directly from the options in the MathType window.





	
Rule #2: You don’t have to type space within Mathematical expressions in the MathType window.

Example:
In the MathType window, when typing y=, you don't have to type a space between the y and the =, because MathType takes care of the spacing automatically. To help you break the habit of typing spaces, the spacebar is disabled most of the time in MathType, so pressing it will have no effect (other than producing a beep sound!). 


	
Rule #3.  For any text appearing within an equation type the text in MathType and choose “Style: Text”.

Note that the default style in the MathType window is “Math”.  This is displayed at the bottom of the window as shown in the image below.


Example 1:


Here the style of the above text would need to be changed to ‘Text’ from ‘Math’.
Hence select the word “Numerator” and “Denominator” and choose Style as ‘Text’ as shown below:
The corrected equation will appear like this – 



Example 2:


The default Style setting is “Math”
Select the words “ones” and “tens” and select Style: Text
It will then appear like this:


Press control space when keeping the cursor before “ones”, and before “ten”, and after “ten”. (This spacing is discussed again in a later point)
The correct equation will appear like this:



Example 3:

 

Select ‘Prob’ and choose Style > Function
Select the word "both", and choose Other from the Style menu. The Other Style dialog box will appear, which lets you directly change the font and style (bold & italic) of selected characters. Click on Bold, and then choose OK.
To get variables A and B in italics choose Math from the Style menu this tells MathType to treat them as mathematical variables.




	
Rule #4. The MathType Equation box in the Word file should be treated as you would treat a word with appropriated spacing before and after it.

i.e. One space should be left before and after the MathType equation box at all times, except:
- if the equation is followed by a punctuation mark. (since no space is kept before a punctuation mark at all times)
or 
- if the equation is at the end of or start of a line. (since no space is given after the last word on a line or before the first word on the line)


Example 1:
(g) 
A space will be given after “(g)” and before the mixed fraction begins.

Example 2:

Is ?
A space will be given between the word “Is” and the MathType expression, no space will be given between the MathType equation and “?”





	
Rule #5. For text and punctuation marks within the MathType equations, spacing should be as per the rules of English.

To type space within the MathType equation press “ctrl key + space bar”.
Example 1:


One space is given after the comma.


	
Rule #6. Handling Punctuation Marks within MathType equations

When dealing with punctuation marks – comma, full stop, exclamation, etc., with the equations, note the following:
- Spacing of punctuation marks should be as per Grammar rules, i.e. no space before them but one space after if followed by some text or equation.
- When we change the Style of the punctuation mark to “Style: text” we need to manually give space after the punctuation mark if we are typing anything ahead of it.
(The spacing within equations is automated and correct only under Style: Math)
- A punctuation within a Math expression should always be inside the MathType box with the style for that punctuation selected as “Style: Text”
**The Full Stop/ Period is the exception to this rule. Keep the full stop outside the MathType box without any space before it, else it gets considered as a decimal point.

Example 1:


Here the comma is typed in the MathType window and the Style for the comma is selected as “Text”.
And there is no space before the comma in the MathType window.

Example 2:


Here the question mark is typed in the MathType window and the Style for the question mark is selected as “Text”.
And there is no space before the question mark in the MathType window.

Example 3:


Here the question mark is typed in the MathType window and the Style for the question mark is selected as “Text”.
And there is no space before the question mark in the MathType window.
(However when the exclamation mark is used to signify the Mathematical concept of factorials this should be left as style: Math. In case you are unsure of the context in which the exclamation mark is used please check this with someone having a Math background.)

IMPORTANT NOTE:
The Full Stop is the exception to this rule. Keep the full stop outside the MathType box without any space before it, else it gets considered as a decimal point.


	
Rule #7. For Units of measurement (m, cm, l, ml, kg, etc) within MathType equations select the style as “Text” and give space before and after the units of measurement.

Example:







	
Rule #8. For blanks within a MathType equation, type the question mark and not 3 hyphens or 1 underscore. Here the question mark sign is left as “Style: Math”

Example:

 is wrong

 is wrong

 is correct


	
Rule #9. It is okay to type many equations in the same MathType window. However do not type full text sentences or phrases in the MathType window.

Example 1:
This is allowed;
[image: C:\Users\SAM\Desktop\MT Image1.jpg]

Avoid this:





This is correct where only  and  is in MathType as shown below.



The adjacent pair of angles whose sum is  is called a linear pair. Here 


	
Rule #10.  Algebraic Variables and Names for Geometry figures that are a part of Math Equations need to be typed in MathType with the style left as “Math”.

- Type in the MathType box and leave style as “Math”
Example:




	
Rule #11.  When typing a single letter / variable that is not a part of a Math Equation it need not be typed within the MathType equation window. But, any two or more letters together need to be typed within MathType equations and left as “Style: Math”.

Example;

A and B are two points on segment.
Here “A” and “B” are typed outside MathType.
However “AB” is typed within MathType.





	
Rule #12. When selecting superscript and subscript, in most cases we choose the first superscript / subscript symbol option. 
[image: C:\Users\SAM\Desktop\MT Image1.jpg]




	
Rule #13. Point your cursor to the symbol and check the symbol name at the bottom of the MathType window as shown below before inserting the symbol.

[image: ]

Example:


For the triangle symbol make sure to use the triangle – () in MathType and not the symbol for Delta ()





	
Rule #14. Underline numbers in MathType as shown below. Do not use the Word underline feature.

Option 1


or

Option 2
[image: C:\Users\SAM\Desktop\MT Image1.jpg]

Rule #15. Use the strikethrough option from the MathType window only as shown in the image below.

[image: C:\Users\SAM\Desktop\MT Image1.jpg]

Do not use the strikethrough option shown in the image below;
[image: C:\Users\SAM\Desktop\MT Image1.jpg]




Some More Shortcuts & How tos

1. Customizing the Toolbar
The Toolbar can be customized to show symbols you use often in the licensed MathType version 
The expressions in MathType’s tabbed bars can be inserted into the equation you are working on with just a single click.
To add your own expression to a bar, just drag it to the desired spot.
To modify an equation on the bar, just double-click on it to open it in its own editing window.
To delete an expression from the bar, right-click and choose Delete.

2. Keyboard shortcuts
Quick Shortcut keystrokes when typing in the MathType window
As you hold the mouse pointer over the palette items their name as well as the shortcut keystroke to access them is displayed in the status bar at the bottom of the MathType window. This will help ensure that you pick the correct template and remember the shortcut key to access them as well. 
Example:
You can also create a superscript slot by typing Ctrl+H ("H" = "high"). 
Ctrl+L inserts a subscript slot ("L" = "low").
Ctrl+F inserts the slot for typing a Fraction, and so on.
Ctrl+Shift+E to change style to text
Ctrl+9 for round brackets (parantheses)
Ctrl+[ for square brackets
Ctrl+R for radical sign (square root sign)



Greek Characters: You can enter a Greek character using Ctrl+G and its equivalent letter, e.g. m for , P for , d for .



3. Copying and Dragging
To re-use part of an existing equation, select the part and then use Copy and Paste, or drag and drop. To copy the selection hold down the Ctrl key when dragging.


4. To type something like 
Keep the cursor before C, select the superscript slot, and type 2 in it. Next, keep the cursor after C, and select the subscript slot, and type 1.

5. To type most Spatial Math Sums
To type all Spatial Math sums, Long Division sums etc. use the Matrices option in MathType as shown below. To create a matrix, use the ‘matrix templates,’ and select the variable-size matrix (shown below). This will allow one to create the matrix with as many rows and columns as needed.

[image: ]

Example:
The equation below was created using a 3 by 5 matrix, with the top two cells in Column One being unused.


6. Instructions to type Long Division sums
A Long Division sum can be typed out in MathType using the fraction template as shown.


You can use tabs for the Long Division sum underneath to line the numbers up. (The tabs are the arrows, of which the one used below is the one furthest to the left, to click and drag it along the ruler to the desired position.) Next, if you press ctrl + tab on the keyboard, it will bring the cursor to the desired position.
How to use tabs is actually a course in the MathType help (Help > MathType tutorials). It can be found by using the index to search for ‘Formatting with tabs.’
Also, to get the line underneath the “0” you will want to use the under-bar template, which is in row 2 column 6. Also, the line spacing will need to be lowered. It can be found in the ‘Format > Line Spacing’ menu.




7. To type Cross Multiplication
Cross Multiplication as shown in the image below can be typed out using MathType and is to be treated as Spatial Math.
In Word you can type out the cross multiplication sign based on the template shared by Design Science. Please contact Design Science or the XRCVC for this template.


8. To Insert a Pascal Triangle
Insert a matrix: 



Set the dimensions of the matrix as described below:
, which for this one is 5 rows, since there are 5 ones along the left or right side, and 11 columns, since there are 6 numbers along the base, so times 2 is 12, and minus 1 is 11. So what you see above is a 5x11 matrix. Before you close the Matrix dialog though, make sure Row Alignment is Baseline, Column Alignment is Center, and Equal Column Widths is checked.

Type the numbers inside in whichever way it works for you, but I think a good technique is to start by typing a 1 in the bottom cell of the first column, proceeding diagonally up and to the right, typing 1 in each cell along that diagonal until you get to the top row. Proceed downward and to the right the same way. Now fill in the middle, skipping a column between each entry.

When you're finished it won't look right – it will be way too spaced out. The one above looked like this at this point: 



You can fix that in MathType by expanding the Format menu, and click the bottom entry: Define Spacing. You need to change 3 things in the Define Spacing dialog:
Change Matrix row spacing to 100%
Change Matrix column spacing to 1%
Uncheck the box labeled Use for new equations.
When you click OK, the triangle should look more normal. Like all templates in MathType, the green dashed rectangles are only to show you where the template slots are, and do not show up in Word.

9. To cancel many things together choose the option in the image as shown below;
[image: ]



10. Number above or below a cancelled number will be written as superscript or subscript numbers as shown below;




11. For expressions with large brackets use the brackets/parenthesis from the MathType (Ctrl + 9) and not the ones directly from the keyboard.
Example:



[image: ]


12. To insert the Slanting Cross lines shown below
Example:
[image: ]
and
[image: ]
Note: It can be done in MathType, but it won’t be accessible. Hence we will create it as a graphic, and add the Alt text.

13. To Insert Circled Numbers
Example:
[image: ]

How to insert in MathType:
For the circled numbers, the user would need to produce a circle and then nudge (move) the number inside it. MathType can use a circle from any font, so if there is a font on the computer that is being used containing a circle, that font can be used to produce it. Instead use the ‘Insert Symbol’ dialog, which is found in the ‘Edit’ drop down menu. Select ‘Insert Symbol,’ and then change the ‘View by:’ drop down menu to ‘Description.’ Click the ‘New search…’ button to search for “circle”. The results will show up below, then click the desired circle and click ‘Insert.’ This will insert the circle into the MathType editor.

 [image: ]
Once the circle is in the MathType editor, it can be highlighted, and then clicked and dragged into an empty place on the MathType toolbar for future use.
[image: ]
Once the circle is in the MathType editor, one can enter the number, size it (ctrl + > or ctrl + < ), and then nudge (move) the number into the circle. To nudge the number into the circle or highlight the number, and then hold the ctrl key, and press the directional arrow keys on the keyboard to nudge (move) it into place.
[image: ]
 
14. To insert Long Division with the quotient to the left or Long Division to find the HCF
Example:
[image: ]

How to:
Use the open or close parenthesis, or use the long division template available for the rounded long division signs after the number 55224 and before the 2.

[image: ]
To achieve the line underneath the “110448,” use the “underbar template.”

The tab functionality, which is explained in the MathType tutorial, i.e. the arrows directly above the workspace, is used to align the numbers. The arrows are to be dragged down to the ruler to be used. After a tab has been inserted, the ctrl + tab shortcut is to be used to tab over to the tab position. This is how the equation is aligned properly.
[image: ]







Handling Math Expressions & Symbols – in the E-Copy
The E-copy remains the same as the Master copy. Nothing changes here.

Handling Math Expressions & Symbols – in the Braille Ready Word File
1. Handling Spatial Math Sums
Let all spatial Math sums be in MathType as inserted in the Master copy. However add the following below the sum;
- To represent the horizontal line for the answer: Below the MathType equation in the Word file type 3 ten times below the equation to represent the horizontal line where needed.
Example:


3333333333
3333333333
- To represent the horizontal line for carry over: If there any kind of carry over in the sum type 7 ten times below the equation.
- For all other spatial Math (Long division, matrices etc.) leave them in MathType.

Handling Math Expressions & Symbols – in the DBT file (Internally)

Spatial Math Alignment (long division, cancellation with fractions, cross multiplication etc) & removing and adding braille symbols as required.
Check & Correct spacing for Large Numbers that are written in the Indian place value system and that are a part of Math expressions.
***

SECTION 3 – HANDOUT FOR E BOOK, DAISY AND BRAILLE

E-Book

1. Naming
Add Space E-book to the file name after the existing name
Example:
Murphy, Raymond, Essential English Grammar, 2nd Edition, 1998, 69th Reprint, 2012 E-book

2. Page number 
For the E-Book, you must remove the 20 hyphens for each page number since a student using a screen reader, would not like to listen to numerous hyphens every time he reaches a new page.
This is done as follows:
Copy the 20 hyphens from any line with the page number, using Ctrl+C.
Press Ctrl+Home.
Press Ctrl+H to open the Find and Replace dialog box.
In the Find what: field, paste the 20 hyphens (--------------------), using Ctrl+V.
Leave the Replace with: field blank (in order to replace the hyphens with nothing).
Click Replace All.

***


DAISY

1. Naming
Add Space DAISY to the file name after the existing name
Example:
Murphy, Raymond, Essential English Grammar, 2nd Edition, 1998, 69th Reprint, 2012 DAISY

2. Page Numbers 
Remove 20 dashes and the word Page and heading level of page numbers.

Remove 20 dashes and the word Page, this is done as follows:
Copy the 20 hyphens, the word Page, as well as the space after that from any line with the page number, using Ctrl+C.
Press Ctrl+Home.
Press Ctrl+H to open the Find and Replace dialog box.
In the Find what: field, paste the 20 hyphens, the word Page, as well as the space
(--------------------Page ), using Ctrl+V.
Leave the Replace with: field blank (in order to replace the hyphens with nothing).
Click Replace All.

***


Braille

1. Naming
Create a folder and name it as follows: Add Space BRF after the existing name
Example:
Murphy, Raymond, Essential English Grammar, 2nd Edition, 1998, 69th Reprint, 2012 BRF


2. Saving and keeping files
All Maths books (of all levels) need to be divided into separate files volume wise.
All Literary books (of all levels) need to be divided into separate files volume wise.

In the new BRF folder, create separate files for each volume
Volume 1 will include:
Copyright / Preface / Foreword / Acknowledgements / Messages by Editor / About the Author / Contents

After creating Volume 1 as explained above, a separate volume is to be created for each of the following in the same order of the sighted print hard copy textbook:
Chapter Number with Name / Index of words / Glossary / Worksheets / Revision / Review / Answers / Solutions or any other similar non-chaptered and non-numbered key sections in the book

Name each volume as:
… space Vol 1
Example:
Murphy, Raymond, Essential English Grammar, 2nd Edition, 1998, 69th Reprint, 2012 Vol 1


3. Inserting Copyright Notice & cover page
Insert the Braille Book copyright notice for each volume and add volume number in the same.
e.g.
Essential English Grammar
Author: Murphy, Raymond
Pages: 300
ISBN: 978-8175960299
Edition: First published in 2014
Publisher: SAGE
Type of Book: Braille
Division of book: 10 chapters
Volume Number: 1 of 11


4. Handling Tables
(a) Aligning the Columns:
(For tables, other than the Table of Contents…)
Option 1: (if characters in each row / line of the table are approximately 20-22 characters, all together)
Unformat tables and either keep the data in columns & rows; by adding the following:
For the Top line, use ten hyphens ----------
For the Intermediary line, use ten 3s 3333333333
For the Bottom line, use ten cs cccccccccc
Between the contents of the table, use 2 hyphens ( -- ) with one blank space before and after.

Example:
----------
Subject -- Predicate
3333333333
1. Birds -- fly
2. The sun -- rises
3. The moon -- shines
cccccccccc

OR

Option 2: (if characters in each row / line of the table are more than 22 characters, all together)
Copy-paste and place the contents of each column one below the other.

The two columns are to be typed one below the other with titles as shown below.

Example:
Column A
1. Apples
2. Mangoes
3. Pears
Column B
a. 20
b. 35
c. 50


For the Table of Contents…
Option 1: (If tables have not more than four columns, and if the columns have no headings)

Master Copy Example:

	1. The Musicians of Bremen
	3

	2. The Brahmin’s Wife and the Mongoose
	15

	3. The Queen’s Necklace
	23



Braille Ready File Conversion:

1. The Musicians of Bremen -- 3
2. The Brahmin’s Wife and the Mongoose -- 15
3. The Queen’s Necklace -- 23

OR

Option 2: (If tables have more than four columns, or if the columns have headings, or if any cell has bullets & sub-bullets)

Master Copy Example:

	Unit

	Comprehension
	Working with Words
	Learning about Language
	Listening and Speaking
	Composition / Activity

	1. Does He Remember?
	An interesting story
--Questions
--Reference to context

	--Sentence completion: words from the passage
--Spelling: error correction
--Collective nouns
	--Parts of speech
--Word association 
--Punctuation

	--Listening comprehension: marking a map

	--Writing a paragraph about the dog in the story

	Stopping by Woods on a Snowy Evening
	An insightful poem
--Questions
--Rhyme scheme
--Reference to context
	--Suffix: -y

	--Functions of words: nouns and verbs

	--Tongue Twisters
Long/short medial vowels
	--Creative piece: conjecture




Braille Ready File Conversion:

Unit:
1. Does He Remember?
Comprehension:
An interesting story
--Questions
--Reference to context
Working with Words:
--Sentence completion: words from the passage
--Spelling: error correction
--Collective nouns
Learning about Language:
--Parts of speech
--Word association 
--Punctuation
Listening and Speaking:
--Listening comprehension: marking a map
Composition / Activity:
--Writing a paragraph about the dog in the story

Unit:
Stopping by Woods on a Snowy Evening
Comprehension:
An insightful poem
--Questions
--Rhyme scheme
--Reference to context
Working with Words:
--Suffix: -y
Learning about Language:
--Functions of words: nouns and verbs
Listening and Speaking:
--Tongue Twisters
Long/short medial vowels
Composition / Activity:
--Creative piece: conjecture

(a) Editing the Questions
In case of tables where the columns are going to be presented one below the other, edit the question as follows:

Example:
The words on the left all begin with the letter ‘boo’. Match each one with the correct meaning on the right.

BRF copy:
The words in Column A all begin with the letters 'boo'. Match each one with the correct meaning in Column B.


(b) Blanks in Tables
In case of blank cells in a table, use three hyphens to represent a blank.
Example:
----------
No. -- Masculine -- Feminine
3333333333
1 -- horse -- ---
2 -- --- -- tigress
3 -- --- -- woman
cccccccccc



5. Handling End of Chapters / Volumes
When creating the Braille Ready File, you must follow these steps:
i. Press Ctrl+End to position your cursor at the end of the file.
ii. Add 12 colons to represent the end of each volume (::::::::::::)

***



SECTION 4 – CHECKLISTS

Master Copy (Math & Non-Math) – Check List

	Section No
	Section Heading
	Item No
	Item Name
	Task
	Applicable for Math Book

	I
	Scanning
	1
	Image Scan
	All pages with images except plain border
	Yes

	
	
	
	
	Front and back covers
	Yes

	
	
	2
	OCR Scanning
	Complete Book: Cover to Cover
	NA

	II
	Saving & Keeping files
	1
	Saving Book
	Save Book in the fixed location
	Yes

	
	
	2
	Naming the Book Folder and Files
	Author Surname, Author Name, Book Name, Edition Number, Year of the Edition
	Yes

	
	
	3
	Naming of OCR File
	Author Surname, Author Name, Book Name, Edition Number, Year of the Edition
	Yes

	
	
	4
	Naming and Saving of Image Folder
	Images
	Yes
Folder Name: Images
Image File Name: Image01, Image02 etc.

	III
	Editing / Proofreading / Formatting Stages
	1
	Copy Paste Unformat
	Unformatted
	No

	
	
	
	
	Font: Calibri 11
	Yes

	
	
	
	
	Left Aligned
	Yes

	
	
	2
	Cleaning up extra Spaces, Tabs, Enters etc.
	Switched on the Paragraph Mode
	Yes

	
	
	
	
	Removed Unwanted Extra Spaces
	Yes

	
	
	
	
	Removed Unwanted Extra Tabs
	Yes

	
	
	
	
	Removed Unwanted Extra Enters
	Yes

	
	
	
	
	Line Spacing 0
	Yes

	
	
	
	
	Spelling and Grammar check
	Yes

	
	
	
	
	Checked for appropriate Extra Lines for Chapter names, page numbers, pictures, tables, text box, section heading, subheading
	Yes

	
	
	3
	Inserting Copyright Notice & Cover Page 
	Insert the XRCVC Copyright Notice & Cover Page
	Yes

	
	
	
	
	Cover Page with Alt text Inserted
	Yes

	
	
	4
	Inserting Page Numbers
	Added twenty “-“s with Page
	Yes

	
	
	
	
	Checked for no space between -Page 
	Yes

	
	
	
	
	Hindi Page Numbers added appropriately
	NA

	
	
	
	
	Added Non Numbers Pages and cover page titles appropriately
	Yes

	
	
	5
	Handling Images
	Cropped Images
	Yes

	
	
	
	
	Included Caption of images in the image
	Yes

	
	
	
	
	inserted blank lines before and after
	Yes

	
	
	
	
	placed images next to one another, one below the other
	Yes

	
	
	
	
	Flow chart: as single images
	Yes

	
	
	
	
	appropriate tag line for tactile diagrams, objects, activity
	Yes

	
	
	
	
	Appropriate Alt Text
	Yes

	
	
	6
	Replacing Visual Words
	Replaced Tick/Colour/Circle/Underline/Cross out
	Yes

	
	
	
	
	Replaced Fill in the box/grid
	Yes

	
	
	
	
	Replaced fill in the words given in box/tree/cloud
	Yes

	
	
	
	
	Replaced Draw line for match the columns
	Yes

	
	
	
	
	Replaced trace over for cursive writing exercises
	Yes

	
	
	
	
	Replaced: Refer words in colour 
	Yes

	
	
	7
	Handling Visual Marked Answers
	Replaced Visual marked Examples with writing the answers
	Yes

	
	
	8
	Retaining Visual Instructions
	Added Tactile Diagrams wherever applicable
	Yes

	
	
	9
	Additional Numbering
	Match the Columns
	Yes

	
	
	
	
	Question without MCQs
	Yes

	
	
	
	
	Questions with  MCQs
	Yes

	
	
	
	
	Tree Diagrams
	Yes

	
	
	
	
	Full stop and space for all numbering followed
	Yes

	
	
	10
	Handling Lists
	Placed Numbered lists one below the other
	Yes

	
	
	
	
	Bulleted lists appropriately arranged
	Yes

	
	
	
	
	MCQ Bulleted lists numbered
	Yes

	
	
	
	
	MCQ non Bulleted appropriately arranged
	Yes

	
	
	11
	Handling Bullets and Sub Bullets
	two dashes for bullets
	Yes

	
	
	
	
	1,2,3 numbering for sub bullets
	Yes

	
	
	
	
	Numbers followed by full stop and space
	Yes

	
	
	12
	Handling Tables
	Inserted tables for contents section
	Yes

	
	
	
	
	Inserted tables for sections required 
	Yes

	
	
	13
	Handling Fill in the Blanks
	three dashes for sentence blanks
	Not for blanks within equations

	
	
	
	
	No dashes for table blanks
	Yes

	
	
	
	
	single dash for single alphabet blanks
	Yes

	
	
	
	
	No dashes for full line blanks
	Yes

	
	
	14
	Handling Text in Boxes
	5 dashes before and after with Text box Begin; Text box end
	Yes

	
	
	15
	Handling Bold Italics Underline
	Applied Bold, Italics, Underlines
	Yes

	
	
	16
	Footnotes
	Inserted Footnotes
	Yes

	
	
	17
	Headings and Sub Headings
	Added Headings and Sub Headings 
	Yes

	
	
	18
	Ending Scanning and Editing Work
	Added your ending work entry
	Yes

	
	
	19
	Proofreading
	Proofreading completed
	Yes




Master Copy (Math Only) – Check List

	Section No
	Section Heading
	Item No
	Item Name
	Task

	I
	Scan Math Hardcopy Books
	1
	Image Scanning
	Key Settings:
Image Color Mode: Black/White
File Type: BMP
Resolution (ppi): 600 dpi

	
	
	2
	Naming the Image files
	Name files as image01, image02, image03 etc.

	
	
	3
	OCR scanning with InftyReader
	Open File & Choose "Start OCR"

	
	
	4
	Converting the Equations to MathType equations
	Use “Convert Equations” button from MathType in Word 

	
	
	5
	Save as .docx
	

	II
	Inserting, Editing & Proofreading 
Math Expressions & Symbols
	1
	Insert, Edit, Proofread Math Expressions
	Proofread & Edit MathType Equations following the 15 Rules

	
	
	
	
	Rule #1. All Mathematical Expressions (i.e. not including plain numbers that are not a part of Math expressions) should be inserted with MathType.

	
	
	
	
	Rule #2: You don’t have to type space within Mathematical expressions in the MathType window.

	
	
	
	
	Rule #3.  For any text appearing within an equations type the text in MathType and choose “Style: Text”

	
	
	
	
	Rule #4. The MathType Equation box in the Word file should be treated as you would treat a word with appropriated spacing before and after it.

	
	
	
	
	Rule #5. For text within the MathType equations spacing should be as per the rules of English.

	
	
	
	
	Rule #6. Handling Punctuation Marks within MathType equations

	
	
	
	
	Rule #7. For Units of measurement (m, cm, l, ml, kg, etc) within MathType equations select the style as “Text” and give space before and after the units of measurement.

	
	
	
	
	Rule #8. For blanks within a MathType equation type the question mark and not 3 hyphens or 1 underscore. Here the question mark sign is left as “Style: Math”

	
	
	
	
	Rule #9. It is okay to type many equations in the same MathType window. However do not type full text sentences or phrases in the MathType window.

	
	
	
	
	Rule #10.  Algebraic Variables and Names for Geometry figures that are a part of Math Equations need to be typed in MathType with the style left as “Math”.

	
	
	
	
	Rule #11.  When typing a single letter / variable that is not a part of a Math Equations it need not be typed within the MathType equation window. But any two or more letters together need to be typed within MathType equations and left as “Style: Math”.

	
	
	
	
	Rule #12. When selecting superscript and subscript in most cases we choose the first superscript / subscript symbol option.

	
	
	
	
	Rule #13. Point your cursor to the symbol and check the symbol name at the bottom of the MathType window as shown below before inserting the symbol.

	
	
	
	
	Rule #14. Underline numbers in MathType as shown and not using the Word underline feature.

	
	
	
	
	Rule #15. Use the strikethrough option from the MathType window as explained in the handout only




Braille Ready File – Check List

	Section No
	Section Heading
	Item No
	Item Name
	Task
	Applicable for Math Book

	II
	Saving & Keeping files
	1
	Saving Book
	Created a folder and Separated Volume files in the folder
	Yes

	
	
	2
	Naming the Book Folder
	Added Space BRF to the folder name after the existing name
	Yes

	
	
	
	
	Added Volume Numbers to each volume file
	Yes

	
	
	3
	Naming of OCR File
	NA
	

	
	
	4
	Naming and Saving of Image Folder
	NA
	

	III
	Editing / Proofreading / Formatting Stages
	3
	Inserting Copyright Notice & Cover Page 
	Inserted the Braille copyright notice for each volume and added the specific volume numbers
	Yes

	
	
	
	
	Added 12 : at the end of the volume ::::::::::::
	Yes

	
	
	12
	Handling tables
	made appropriate changes
	Yes

	
	
	
	
	
	

	Additional Points for Maths - Braille Ready File
	
	

	
	
	
	Handling Spatial Math Sums
	Type the number 3 ten times (to look like 3333333333) for the horizontal lines

	
	
	
	
	Type the number 7 ten times (to look like 7777777777) when the sum has numbers carried over
	

	Additional Points for Maths - DBT Soft Copy
	
	

	
	
	
	Spatial Math Alignment 
	(Long division, cross multiplication etc.) & removing and adding braille symbols as required.
	

	
	
	
	Large Numbers in Indian place value system
	 Check & Correct spacing for Large Numbers that are written in the Indian place value system and that are a part of Math expressions.
	




EBook – Check List

	Section No
	Section Heading
	Item No
	Item Name
	Task
	Applicable for Math Book

	II
	Saving & Keeping files
	1
	Saving Book
	NA
	

	
	
	2
	Naming the Book Folder
	Added Space E-book to the file and folder name after the existing name
	Yes

	
	
	3
	Naming of OCR File
	NA
	

	
	
	4
	Naming and Saving of Image Folder
	NA
	

	III
	Editing / Proofreading / Formatting Stages
	4
	Inserting Page Numbers
	Remove 20 hyphens (use Ctrl + H)
	Yes

	
	
	
	
	
	

	Additional Points for Maths - Ebook
	
	

	
	
	
	NOTHING CHANGES
	
	





DAISY – Check List

	Section No
	Section Heading
	Item No
	Item Name
	Task

	II
	Saving & Keeping files
	1
	Saving Book
	NA

	
	
	2
	Naming the Book Folder
	Added Space DAISY to the file and folder name after the existing name

	
	
	3
	Naming of OCR File
	NA

	
	
	4
	Naming and Saving of Image Folder
	NA

	III
	Editing / Proofreading / Formatting Stages
	4
	Inserting Page Numbers
	Remove 20 hyphens and the word Page (use Ctrl + H)

	
	
	
	
	Remove Heading Level for Page No.



~ The End ~
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